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Overview of Useful Photoshop Skills
Over the past decade or so, we have found 

the following Photoshop tools extremely use-
ful to radiologists and believe that this review 
will help radiologists quickly and easily en-
hance their skills in manipulating images for 
teaching and publication. We describe the 
Photoshop user interface to ensure that readers 
can easily find and use the tools and settings 
described, briefly define layers and gray-scale 
images, and describe the useful tools.

Journals usually require that images be pro-
vided in a standard format, such as 300 pixels/
inch TIFF. A group of images in a single fig-
ure usually appears more pleasing if the im-
ages are the same size along one or both of 
their dimensions (horizontal and vertical). In 
the section on resizing of images, we describe 
how to enlarge and reduce images and how 
to change the image resolution. With these 
skills, the user can generate, for example, sev-
eral 300-pixels/inch TIFF images that are all 3 
inches (7.62 cm) wide regardless of the initial 
size and resolution.

Two retouching tools can be used to pre-
vent patient information from being inadver-
tently distributed and to clean up an image. 
The Clone Stamp tool is used to replace se-
lected pixels (such as patient information) 
with other pixels (typically the black back-
ground of an image). This tool permanently 
replaces the pixels that previously contained 
patient information so that this information 
cannot be recovered. The process is more ef-
fective than covering patient information with 

A
dobe Photoshop (Adobe Systems) 
and other brands of image-pro
cessing software have become 
essential tools for radiologists, es-

pecially those involved in teaching and re-
search. Yet many radiologists are not trained 
in these tools and often learn them quickly 
(and ineffectively) when their first projects 
are due. The complexity of the software can 
be daunting, forcing many radiologists to get 
by with the crude and limited basic tools 
they discovered or were shown in their initial 
attempts at image editing. Although there 
are excellent books that describe the full po-
tential of Photoshop [1], radiologists need to 
master only a small subset of the tools avail-
able, some of which have been described in 
the literature [2–5].

We describe a few essential Photoshop 
tools that users can quickly apply. Concise, 
step-by-step instructions are provided to mini
mize the frustration that can result from at-
tempting to navigate a complex user in-
terface, especially for those with minimal 
experience. We describe the use of Photo-
shop CS4 on an Apple Mac running Mac OS 
X version 10.6.8. The commands and key-
strokes may be slightly different in other 
versions of the operating system or of Pho-
toshop, but most of the operations described 
are consistent from version to version and 
across platforms. The interface is slightly 
different on computers running the Microsoft 
Windows operating system, and a few of the 
common differences are discussed.

OBJECTIVE. The purpose of this review is to describe the use of several essential 
techniques and tools in Adobe Photoshop image-editing software. The techniques shown 
expand on those previously described in the radiologic literature.

CONCLUSION. Radiologists, especially those with minimal experience with image-
editing software, can quickly apply a few essential Photoshop tools to minimize the frustration 
that can result from attempting to navigate a complex user interface.
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a black box (or similar structure) in, for exam-
ple, Microsoft PowerPoint software because 
the black box can be deleted and the under-
lying patient information revealed. The Spot 
Healing Brush tool is used to paint over a se-
lected area with pixels that are similar in ap-
pearance and texture to the surrounding pixels.

Although the better-known Brightness and 
Contrast tools can be used for quick and easy 
adjustment of images, changes are applied to 
the entire image. As a result, lightening of a 
dark area can result in excessive lightening 
of areas that previously were well visualized. 
We describe the powerful but less well known 
Shadows/Highlights tool, which can be used 
to lighten dark areas and darken light areas 
without adversely affecting the midtones.

The Line tool is used to generate lines and 
arrows and to control the size, shape, and color 
of these structures. The skills description ends 
with the Line Art tool, which is used to generate 
line-art diagrams from radiologic images.

Introduction to Photoshop
To begin, we clarify some common terms. 

The terms “click” and “left-click” mean press 
the left mouse button once. “Right-click” 
means press the right mouse button once. For 
a single-button mouse (Mac), pressing once is 
equivalent to a left click, and holding down 
the Control key while clicking the mouse is 
equivalent to a right-click.

To ensure access to all the tools and op-
tions described in this review, we recommend 
that Mac users select, or enable, Application 
Frame, Options, and Tools in the Window 
dropdown menu, as shown in Figure 1. To do 
this, click on the Window dropdown menu, 
and a vertical list of options is displayed. If 
there is no checkmark to the left of Applica-
tion Frame, Options, or Tools, slide the mouse 
down to highlight one of these lines and click 
once. The dropdown menu disappears, but 
when clicking on Window reopens the drop-
down menu, a checkmark will be present on 
the selected line, or option. Repeat this pro-
cess until checkmarks are present to the left of 
all three choices. (When Application Frame 
is checked, Application Bar is also automati-
cally checked but is dimmed and cannot be 
modified). Users of Microsoft Windows se-
lect Options and Tools; Application Frame 
and Application Bar are not available choices.

Making the foregoing selections ensures 
that the Option bar and Tools panel are both 
visible and available for use (Fig. 2). The 
Tools panel usually appears on the left of the 
screen as a vertical panel. It is a convenient 

method of selecting the desired tool. Some 
of the tools have options that appear in the 
context-sensitive Options bar (meaning that 
the contents of the bar change depending on 
the tool selected). Clicking on the double ar-
rows at the top of the Tools panel switches 
between displaying one tool per line and dis-
playing two tools per line.

Most tools are grouped into sets of related 
tools. A single icon is displayed in the Tools 
panel for each group of tools, representing 
the default tool for this group or the most 
recently used tool in the group. A small 
triangle at the lower right corner of the tool 
icon indicates the presence of additional 
hidden tools in the tool group. Right-click (or 

hold down the left mouse button) on any tool 
icon displaying the small triangle to display 
the currently displayed tool and all related 
hidden tools. In the example shown in Figure 
3, the Patch tool is activated by clicking on 
the icon for the Patch tool in the Tools panel. 
To activate a tool not currently displayed in 
the Tools panel, such as the Spot Healing 
Brush tool, right-click on the icon for the 
Patch tool, and all the tools in this group are 
displayed in a small window to the right. The 
desired tool can be activated by sliding the 
cursor over the tool and clicking.

If the desired tool does not appear in the 
Tools panel and you do not know which group 
of tools it is in, simply work your way through 

Fig. 1—Window 
dropdown menu. 
Checkmarks indicate 
selection, or enabling, 
of Application Frame, 
Options, and Tools.

Fig. 2—Option bar 
(horizontal arrow) and 
Tools panel (vertical 
arrow) visible and 
available for use.
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all the displayed tools with triangles indicat-
ing hidden tools, right-clicking to see if the de-
sired tool is listed as one of the hidden tools. 
This can be done fairly rapidly and allows you 
to find your tools until you become familiar 
with the grouping of tools. If the group of tools 
is not displayed, right-click again because two 
clicks are sometimes necessary, depending on 
your last actions.

In Photoshop, several modifier keys on 
the keyboard are used. These keys alter the 
actions of standard keys. For example, the 
Shift modifier key, which is identical for Mac 
and Windows, instructs the computer to input 
a capital letter (e.g., H) when a lowercase 
letter key (e.g., h) is pressed. The following 
are several keyboard modifier keys:

•	 Control key (labeled Ctrl or Control)
•	 Alt (Windows computers)
•	 Option (Mac computers), which may 

also be labeled Alt
•	 Command (Mac computers), which may 

bear the Apple icon or four leaf clover 
symbol in addition to or instead of the 
word command.

In almost all cases, the Command and Option 
keys for Mac computers are equivalent to the 
Ctrl and Alt keys for Windows computers.

In this review, actions for the user to take, 
keys to press, and input to provide are iden-
tified in quotation marks to distinguish user 
input from the surrounding text. Key com-
binations are shown with hyphens, the mod-
ifier key listed first. Thus “Command-0” 

means press the Command key, hold it down 
while pressing the 0 (zero) key, and release 
both keys.

When several steps are needed to perform 
an action, they are listed sequentially and 
separated by arrows. For example, to convert 
an image to gray-scale, click on the Image 
dropdown menu at the top of the screen and 
slide the cursor down to highlight Mode, 
which brings up another menu of options, 
including Gray-scale, which can be selected. 
These steps would be designated “Image → 
Mode → Gray-scale.”

One of the most useful commands in 
Photoshop is Undo (“Command-Z”), which 
reverses or undoes the previous command, 
returning the image to its previous state.

Layers
Photoshop has a feature called Layers, 

which can function as the transparent sheets 
of acetate used in the past with overhead proj-
ects. As with the older method, one can gener-
ate an arrow on the top layer and move it over 
an image on the bottom layer to control where 
the arrow points. Empty transparent areas of 
the top layer allow clear visualization of the 
image below. The top-layer structures can be 
made completely opaque, blocking the under-
lying portions of the lower image, or they can 
be made partially transparent and reveal some 
of the detail in the image immediately under 
the structure.

Layers are much more powerful than the 
simple acetate sheets they replace because 
they can function as adjustment layers that 
affect the appearance of the image on the 
layer or layers below. This feature is de-
scribed later (see Shadows/Highlights).

Initial Steps in Obtaining and 
Working With Gray-Scale Images

We assume in this review that users 
know how to export images from their 
PACS. It is best to export images as TIFF 
files because these are full-resolution imag-
es and have maximum flexibility. Although 
the tools we describe can also be applied 
to JPEG-formatted images, JPEG format is 
not recommended for images being edited 
because it usually results in so-called lossy 
compression and degradation of the image 
each time it is edited and saved. Another 
popular file format is GIF, which is com-
monly used for graphics that have a small 
number of colors. GIF, however, supports 
only 256 shades of gray and is unsuitable 
for processing radiologic images.

After opening an image in Photoshop, 
convert it to gray-scale to remove color 
information. Even if the image appears not to 
contain any color, it may have been saved as 
a color image, which is a larger file and less 
convenient to use. The steps are “Image → 
Mode → Gray-scale.”

Resizing Images
Photoshop has a convenient and powerful 

tool for changing the size of an image (i.e., 
resizing it). “Image → Image Size” (Fig. 4A) 
opens the Image Size window (Fig. 4B). We 
recommend leaving the following options 
checked:

•	 Scale Styles
•	 Constrain Proportions
•	 Resample Image
Scale Styles rescales objects such as ar-

rows and lines you may have added, so they 
are changed by the same percentage as the 
associated image, maintaining their relative 
appearance, size, and location with respect 
to that image. Constrain Proportions ensures 
that the dimensions (width relative to height) 
of the image are not independently modified 
when the image is resized. Resample Image 
allows Photoshop to resample the image ac-
cording to the selected algorithm to produce 
an image of the size specified by the user.

The dropdown menu at the bottom of the 
Image Size window (Fig. 4C) is used to spec-
ify how the image should be resampled when 
it is resized. Photoshop conveniently helps 
identify the sampling method to use by spec-
ifying the best method for enlarging (Bicu-
bic Smoother) or reducing (Bicubic Sharper) 
image size. We suggest that you follow these 
recommendations.

When all of the foregoing parameters have 
been selected, the image resolution can be 
modified, if needed. A common resolution for 
printed images is 300 pixels/inch and is used 
in this example. Resizing is accomplished 
by specification of a new width or height for 
the image. To produce a 3-inch-wide (7.6 cm) 
printed image at 300 pixels/inch (also some-
times incorrectly referred to as dots per inch 
[dpi]), specify a width of 900 pixels (3 inch-
es × 300 pixels/inch) in the Pixel Dimensions 
box. Photoshop then resamples the image using 
the method selected and produces a new im-
age that is 900 pixels wide with a height pro-
portional to the original image. Alternatively, 
the width can simply be set to 3 inches in the 
Document Size box, and Photoshop generates 
a 900-pixel-wide image using the previously 
specified resolution of 300 pixels/inch.

Fig. 3—Right-clicking on Patch tool in Tools panel 
opens window that displays related tools to right, 
including Spot Healing Brush, Healing Brush, and Red 
Eye tools.
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Retouching Tools
The following groups of retouching tools 

are available in Photoshop:
•	 Spot Healing Brush, Healing Brush, 

Patch, Red Eye
•	 Clone Stamp, Pattern Stamp
•	 Eraser, Background Eraser, Magic Eraser
•	 Blur, Sharpen, Smudge
•	 Dodge, Burn, Sponge
We describe the Clone Stamp and Spot 

Healing Brush tools. As with all editing tools 
used for publication, these tools should not be 
used to change the diagnostic information in 
an image [6]. They are useful for eliminating 
textual information not necessary on the im-
age or that must be removed for HIPAA com-
pliance, such as patient name and medical re-
cord number, and for removing overlying 
material that can confuse or complicate inter-
pretation, such as partially visible tubes and 
lines, foreign bodies, and cassette artifacts.

Clone Stamp Tool
The Clone Stamp tool copies pixels from 

one portion of the image (referred to as the 
source or sample) to another portion of the 
image (referred to as the destination). The 
cloning or copying function is also sometimes 
referred to as painting. This tool is similar to 
the copy and paste feature in many word-pro-
cessing programs, but it has additional power 
in that pasted pixels can be blended into the 
surrounding image at the destination. There 

are two fundamental steps to cloning: select-
ing the source area to clone (i.e., copy) and 
specifying the destination area into which the 
source pixels should be pasted. Other vari-
ables that affect cloning are described in the 
following procedure.

To begin using the tool, select the Clone 
Stamp tool from the Tool panel (Fig. 5, long 
arrow). Ensure that the Option bar is visi-
ble. If not, make it visible (“Window → Op-
tions”). In the Option bar, click on the down-
ward-pointing triangle in the Brush Preset 
picker (Fig. 5, short arrow) to select the de-
sired brush size (Master Diameter) and de-
sired border sharpness (Hardness) by man-
ually specifying these two parameters or by 
selecting one of the predefined brushes. We 
recommend beginning with the following:

•	 Master Diameter: 50 pixels
•	 Hardness: 50%
The other parameters for this tool are 

specified in the Option bar, as follows:
•	 Mode: Normal
•	 Opacity: 100%
•	 Flow: 100%
•	 Aligned (unchecked for now; useful when 

familiarity with the tool is gained)
•	 Sample: Current Layer
The following example (Fig. 6) shows how 

to copy black background over a patient’s name 
and medical record number while preserving 
the right side marker. Move the cursor over 
the image, where it appears as an outline of 
a circle, representing the brush size (Master 
Diameter) used for cloning the source. The 
brush size can be adjusted by pressing “[” 

A

Fig. 4—Adjustment of image size.
A, Image Size tool accessed from Image dropdown menu.
B, Entry of desired size and in Image Size window. Options such as Scale Styles 
can be selected or deselected.
C, Dropdown menu for selection of algorithm for resizing image.

B

C
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Fig. 5—Clone Stamp tool 
(long arrow) is selected 
from Tool panel. Brush 
size and hardness are 
selected by clicking 
on downward pointing 
triangle (short arrow) in 
Option bar.

Fig. 6—Clone Stamp tool.
A, Initial image contains name and medical record number (fictional for this example), which must be removed before publication. Small arrow, or cursor, above name 
indicates source area being cloned, that is, black background above text.
B, Once appropriate size and hardness of brush are selected, clicking over medical record number copies black background being cloned over text.
C, Image before removal of patient information.
D, Image after removal of patient information.

and “]” (left and right bracket keys) to de-
crease and increase the brush size.

Select the source area from which to clone 
or copy pixels. Select the black background 
above the text to be hidden by placing the cur-
sor in this location (Fig. 6A). Use “Option-
Click” (hold down the Option key and click the 
mouse) to copy this area. The cursor chang-
es to a target icon when the Option key is held 
down and turns into an outlined circle when the 
Option key is released.

Move the cursor to the destination area 
(in this example, the patient’s name and 
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medical record number). The contents of 
the circle show the source pixels that will 
be pasted into the destination area (Fig. 6B). 
Note that the periphery of the circle does not 
completely cover the text. This effect is due 

A B

Fig. 7—Foreign body removal with Spot Healing 
Brush tool.
A, Image shows small metallic foreign body (arrow) 
overlying distal forearm.
B, Final image shows results of removal of  
foreign body.

Fig. 8—Spot Healing 
Brush tool (long arrow) 
is selected from Tool 
panel. Brush Picker 
window is opened by 
clicking on downward 
pointing triangle (short 
arrow) in Option bar.

A B
Fig. 9—Shadows/Highlights.
A, Original image does not show Weight Bearing label, and portions of foot are too bright.
B, Final image after adjustments with Shadows/Highlights tool shows Weight Bearing label, bony structures that were too bright (such as metatarsal heads and 
overlapping talus and malleoli), and soft tissues that were too dark (such as tip of great toe).

to the specified hardness of 50%, which re-
sults in blending of the pasted pixels with 
the original destination pixels. Click once to 
copy the pixels from the source to the select-
ed destination.

To cover a larger destination area, hold down 
the mouse button while moving the cursor 
over the destination area. The source area is 
designated with cross hairs (a small cross or 
plus sign). The source pixels copied to the 
larger destination area are not the same pix-
els as the smaller area originally selected but 
are located at the same relative position on the 
image with respect to the destination area. For 
example, if the initial destination area is 300 
pixels to the right of and 70 pixels below the 
source pixels, the new source pixels will always 
be provided by the pixels 300 pixels to the left 
of and 70 pixels above the destination pixels.

If the mouse button is released (with or 
without moving the cursor) and then held 
down again to continue cloning, this tool pro-
vides two options for the source pixels. It can 
either use the same source that was originally 
selected (if the Aligned option is unchecked), 
or it can use a new source at the same relative 
position as the last selection (e.g., 300 pixels 
to the left of and 70 pixels above the destina-
tion area, if the Aligned option is checked). 
In other words, each new round of cloning 
starts with source data from the originally se-
lected position (if the Aligned option is not 
selected) or from the same relative position 
(if the Aligned option is selected).

Figure 6C shows the initial image with the 
patient information to be removed. Figure 6D 
shows the final image with the patient infor-
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mation removed. If the source area extends be-
yond the margins of the image, there is no im-
age to clone or copy, and nothing is changed in 
the destination area.

Spot Healing Brush Tool
The Spot Healing Brush tool also replac-

es the specified pixels of an image. Howev-
er, rather than copying them from a source 
specified by the user (as with the Clone Stamp 
tool), the Spot Healing Brush automatical-
ly samples around the specified area and re-
places the selected pixels with pixels similar to 
their neighbors so that the area blends in with 
the surrounding image. This tool can be use-
ful for replacing cassette artifacts and unrelat-
ed overlying material (foreign bodies) on an 
image with similar surrounding pixels. If the 
surrounding pixels are not appropriate for re-
placing the selected area, the Clone Stamp tool 
may be more appropriate.

The following example describes use of the 
Spot Healing Brush to remove an overlying 
foreign body from a forearm radiograph (Fig. 
7A). The final corrected image is shown in 
Figure 7B. Select the Spot Healing Brush tool 
from the tool panel (Fig. 8, long arrow). On 
the Option Bar, click on the downward point-
ing triangle to open the Brush Picker window 
(Fig. 8, short arrow). Select the desired brush 
size (Diameter), border sharpness (Hardness), 
and Spacing by specifying these three param-
eters or by selecting one of the predefined 
brushes. We recommend starting with the fol-
lowing parameters:

•	 Master Diameter: 50 pixels
•	 Hardness: 50%
•	 Spacing: 1%

•	 Angle: 0°
•	 Roundness: 100%

Then specify the other parameters for this 
tool in the Option bar, as follows:

•	 Mode: Normal
•	 Type: Proximity Match
•	 Sample All Layers: Unchecked
To make the brush size slightly larger than the 

area being retouched (which allows correction 
with a single click), type in the desired value or 
increase or decrease the brush size using the 
“[“ and “]” keys. Place the cursor (circle) over 
the area to be retouched and click.

Shadows and Highlights
Shadows/Highlights is a method for im-

proving both the light and the dark areas 
of an image with a nondestructive imaging 
technique. When an image is modified with 
standard editing tools such as brightness and 
contrast adjustments, Photoshop (and other 
editing software) changes each pixel in the 
image to reflect the adjustments. If this ed-
ited image is opened again after it has been 
saved, it cannot be restored to its original ap-
pearance, which is lost or destroyed. This is 
not a problem if the edited image is the final 
version, but often, additional adjustments are 
needed or the image needs further editing to 
show different findings. Nondestructive edit-
ing allows modifications without altering the 
original image. Photoshop stores the origi-
nal image along with information specifying 
the changes made. Thus the original image is 
available for new edits.

The overall brightness of an image can be 
adjusted with the brightness tool. Howev-
er, we often need to brighten a portion of an 

image while leaving the rest as is or darken-
ing it. For example, we may want to bright-
en only the soft-tissue detail on a radiograph 
while leaving the bones unaffected or dark-
ening them to bring back marrow detail. This 
frequently needed task can be accomplished 
with the following simple Photoshop method.

The initial image (Fig. 9A), a lateral view 
of the foot, shows some of these challenges. 
The words Weight Bearing near the center of 
the image are not visible, and subcutaneous 
soft tissues are not well depicted in the pe-
riphery of the leg and foot. Portions of the 
osseous structures, such as the overlapping 
bones of the metatarsal heads and the overlap 
of the talus with the medial and lateral malle-
oli, are too bright and are difficult to evaluate.

Start by ensuring that the Layers tool pal-
ette is displayed. If it is not, display it (“Win-
dows → Layers”). In the Layers palette, right-
click on the word Background and select 
Convert to Smart Object. A new icon appears 
over the right lower corner of the thumbnail 
of the image to indicate that it is now a smart 
object, and the name of the layer changes 
from Background to Layer 0 (Fig. 10).

Ensure that Layer 0 is selected (highlight-
ed). If not, click on Layer 0 to select it. Acti-
vate the Shadows/Highlights tool (“Image → 

Fig. 10—Smart Objects. 
Icon of overlying 
rectangles appears 
over lower right corner 
of image thumbnail 
(arrow) to indicate that 
image has become 
Smart Object.

Fig. 11—Shadows/Highlights dialog box contains 
sliders to control dark and bright regions of image 
independently and adjustments for overall brightness 
and mid tones.
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Adjustments → Shadows/Highlights”). In the 
dialog box that opens (Fig. 11), check the box 
next to Show More Options (at the bottom of 
the window), if it is not already checked.

The first three sliders affect the shadows 
(or darker areas of the image). Amount spec-
ifies how much to brighten the darker areas. 
Tonal Width specifies the width of the gray-
scale area affected by this command. Larger 
values affect more of the midtones in addi-
tion to the shadows. If you wish to bright-
en only the darkest areas, select a low val-
ue. Conversely, if you wish to brighten the 
midtones and the darkest areas, select a large 
value, closer to 100%. Radius controls the 
size of the neighborhood around each pixel, 
which is evaluated to determine whether a 
pixel is in the shadows or highlights. A large 
radius tends to lighten more of the image 
rather than just the shadows. The next three 
sliders affect the Highlights (brighter areas of 
the image) in a manner analogous to Shad-
ows, except that Amount specifies how much 
to darken the brighter areas.

In the Adjustments box, the Brightness slid-
er affects the overall brightness of the entire 
image. Adjusting Midtone Contrast can help 
correct low-contrast or muddy-appearing 
midtones. We do not routinely adjust Black 
Clip or White Clip.

Toggling the Preview checkbox allows 
comparison of the original and the modified 
image. The resulting image (Fig. 9B) is im-
proved, and the words Weight Bearing are 
more visible. The extent of the soft tissues 
is fully depicted (shown well in the anterior 
tibial soft tissues and the soft tissues distal to 
the great toe). There is improved osseous de-

tail of the overlapping talus and malleoli and 
of the overlapping metatarsal heads.

Save the final image as a TIFF file. Doing 
so preserves the initial image and all the ed-
iting changes made. The file can be reopened 
for continued editing, or the image can be re-
stored to its original state and editing started 
from scratch.

The final image generally needs to be flat-
tened for use in a publication or presentation 
(“Layers → Flatten”). This process eliminates 
the separate layers and simplifies the way the 
file is stored without changing the appearance 
of the image. The file should then be saved 
with a different name (e.g., lateral_foot_flat-
tened) to prevent overwriting the layered file, 
which contains the original, unmodified image 
and the edits applied).

Lines and Arrows
The Line tool is used to draw lines and ar-

rows. Arrows are commonly added to high-
light areas of interest on a radiologic image. 
This section explains how to easily add lines 
and arrows.

Select the line tool. If the Line Tool icon 
is already shown on the tool bar, click on it 
to select the line tool. If it is not displayed, 

right-click on the related tool and select Line 
Tool (Fig. 12). With Line Tool selected, place 
the cursor where the line will begin, click and 
hold the mouse button, and drag the mouse to 
create the line. Release the mouse button to 
terminate the line at the desired location. The 
black arrow pointing to Line Tool in Figure 
12 was produced with this method.

Select the width of the line before drawing 
the line. Specify the width by typing in its 
weight (width) on the Option Bar (Fig. 13, 
short arrow). Although the weight can be 
specified in inches (in) and centimeters (cm), 
pixels (px) are more commonly used. Start 
with 5 px to 20 px, and adjust up or down to 
produce the desired line width.

To change the color of the line, click on 
the colored box to the right of Color on 
the Option bar, and select a color for the 
line (Fig. 13, long arrow). For most print 
radiology publications, a black or white, not 
color, arrows are used.

To generate an arrow rather than a simple 
line, with Line Tool selected, click on Geom-
etry Options (the downward pointing triangle 
to the left of Weight) on the Options bar. This 
opens the Arrowheads window (Fig. 14). 
Check the appropriate box to specify whether 

Fig. 12—Line Tool selection. If Line Tool is not 
already selected on Tool bar, right-click on related 
tool displayed (in this case, Rectangle Tool) to open 
window containing related tools. Click on Line Tool 
(arrow) to select it.

Fig. 13—Line tool weight and color selection. Weight (width) of line is specified by typing desired size and units 
(in this case, 5 pixels) in Weight box (short arrow). Color is selected by clicking on Color box (long arrow).

Fig. 14—Arrows. Arrowhead is added to line by clicking on Geometry Options (downward pointing triangle to 
left of Weight). Arrowheads window is used to specify location (start, end, or both start and end of line) and 
size and shape of arrowhead.
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Fig. 16—Glowing Edges dialog box has slider bars for 
setting three parameters that determine appearance 
of edges.

the arrowhead should appear at the starting 
point of the line or at the endpoint, or check 
both boxes for arrowheads at both locations. 
The width and length of the arrowheads are 
with respect to the weight (width) of the line. 
We recommend the following values:

•	 Width 500%, to produce an arrowhead with 
maximum width 5 times as wide as the line.

•	 Length 1000%, to produce an arrowhead 
with length 10 times as long as the width 
of the line.

•	 Concavity 0, to produce simple, straight-
bordered arrowheads.

The arrows are generated on separate layers 
and may have to be flattened in the final image, 
as discussed earlier in Shadows and Highlights.

Line Art
A diagram outlining the main structures 

in an image is often useful for showing 

anatomic and clinical findings, particularly for 
teaching purposes. Use of a line-art diagram 
corresponding to a real radiologic image is a 
simplified method of showing the elements 
being referred to on the radiologic image.

Two techniques for generating line-art 
medical images have been previously report-
ed [7]. We describe a new technique that has 
worked well for us and show how to create 
simple line-art diagrams from radiologic im-
ages. No artistic or drawing skills are required. 
This technique may not work with all images, 
especially those without well-defined edges 
(e.g., nuclear medicine and ultrasound studies) 
or with overlying structures that are interpret-
ed as edges. However, it is a quick and sim-
ple technique and may be worth attempting for 
any images that may be useful as line art.

Start with a gray-scale image, such as Fig-
ure 15A. Apply the filter (“Filter → Stylize → 

Fig. 17—Levels dialog box shows histogram of 
densities of pixels in image. Three sliders below 
histogram are used to modify appearance of 
image. Checking Preview shows changes in image 
appearance in real time.

A

C

Fig. 15—Line art.
A, Initial gray-scale image of skull.
B, Image after application of Glowing Edges filter shows white lines on black background.
C, Image after inversion shows black lines on white background.
D, Image adjusted with Levels dialog box shows fine-tuned final image.

B

D

Glowing Edges”). A dialog box (Fig. 16) ap-
pears that contains three slider bars. Edge 
Width specifies how wide to make the edg-
es of the image, and Edge Brightness speci-
fies how bright to make the edges. Smooth-
ness specifies how much detail to discard 
or keep in portions of the images that have 
less obvious edges. A high number discards 
much of this detail and can be useful for hid-
ing internal structures and surrounding mate-
rial. Selecting the optimal parameters can be 
a challenge because compromises have to be 
made between ensuring inclusion of all edges 
of interest and excluding unwanted details in 
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the image. After all parameters have been set, 
click the OK button to accept the changes and 
return to the main Photoshop window.

The image generated so far shows white 
lines on a black background (Fig. 15B). To 
convert this image to a more typical one with 
black lines on a white background, invert the 
image (“Image → Adjustments → Invert”). 
The image produced (Fig. 15C) may have 
lines that are not as well defined as desired 
or may show details from the original image 
that are distracting. Both of these issues can 
be addressed in the final step, in which the 
gray-scale levels are adjusted.

Use “Image → Adjustments → Levels” to 
access the Levels dialog box (Fig. 17) which 
contains a histogram of the densities of pixels 

in the image (Input Levels). The three slid-
ers (small triangles) along the base of the his-
togram control the appearance of the image. 
The left slider controls the darker, or blacker, 
areas of the image; the right slider controls 
the brighter, or whiter, areas of the image; 
and the middle slider controls the middle, or 
gray, areas of the image. Ensure that the Pre-
view option is checked, so that the changes 
are shown on the image in real time. The final 
line-art image is shown in Figure 15D.
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F O R  Y O U R  I N F O R M A T I O N

The reader’s attention is directed to part 2 accompanying this article, titled “Software Aids for 
Radiologists: Part 2, Essential Apps for Handheld Devices,” which begins on page W714.
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This article is available for CME/SAM credit. Log onto www.arrs.org, click on AJR (in the blue Publications box), 
click on the article name, add the article to the cart, and proceed through the checkout process.


